MX-2424 Basics

  The MX-2424 Hard Disk Recording System is essentially the same as all computer based recording systems, with one basic difference. That difference is that the MX-2424 is optimized in one single unit, with the recording of High Quality Audio, as its main function. Additionally included in the system is the MX-View, computer assisted, operational and editing software that enhances the ability of the unit to stand with the best recording systems on the market.

MX-2424 System Configuration:

  The first premise of the MX-2424 is adaptability. The Unit comes standard without any audio I/O’s, (Inputs/Outputs), except for the AES/EBU and S/PDIF stereo I/O on the back. The User has a choice over which audio I/O’s they would like in the unit, as well as various drive systems for recording and backup. Another of the I/O options on the rear of the unit is the SCSI interface that allows you to connect extra hard drives. Additionally there is also an “Ethernet” port to facilitate connection to a computer for operation of the MX-View software, as well as backup and restore functions, plus Importing and Exporting to the computer.

  You will also find I/O’s for Video Sync, Word Clock, SMPTE Time Code and MIDI Machine Control and MIDI Time Code. These I/O’s help in clocking and syncing the system to all of other units of digital equipment and hardware you might have in your system.

  When setting up a system it is first necessary to think of what type of system you will be putting together. All though the MX-2424 can be used as a stand-alone system with your mixer, it will work best as an integrated system with a computer. Deciding what type of computer system you will be using with the MX-2424 is crucial. This includes the digital audio software and sound card you will want to use with your computer. This is important, because selecting the same type of audio I/O for the MX-2424 that you will be using with your computer system, allows you to transfer audio back and forth easily between the MX-2424 and your computer by simply playing it into the other system. The MX-2424 has the ability to have both an analog I/O and a choice between an AES/EBU, T/DIF or ADAT Lightpipe digital interface. Because of this, it is necessary that you evaluate which audio I/O will be best suited to fit your particular needs and allow you to interface with your computer and its sound card. 
[This is important, as the more interfacing and backup options you have; the better your projects will be protected against accidental loss.]
MX-View Software:

  The MX-View software is an operational control and editing software that allows the MX-2424 to be controlled via the Ethernet interface, from your computer. This facilitates transport control and waveform editing down to 100th of a second accuracy. It also allows you to display your project’s Metering and show an Overview of all its tracks, as well as allowing you to set Groups, Markers and see the individual files within the Projects on each of your drives. These files will be found in the Project/Tracks window. It will also allow you to use the “Ethernet” connection for back up, and importing and exporting.

  The MX-View software runs on a PC with Windows 98 thru XP. On the Mac, only OS 8.6 to 9.2.2 are supported. There is no support for OS-X.

  To connect the MX-View software to your computer you need only to set the IP Address of the computer, which is found by right clicking on your computer’s “My Network Places” and selecting Properties so that the Network Connection window appears. Then click the “Local Area Connections” and find the Properties window and open the “Internet Protocol (TCP/IP)” and set the IP Address in this window to one number greater than that of the IP Address of the MX-2424, which is found in Menu 950. [Example: if Menu 950’s, IP Address is 192.168.000.001, the computer’s IP Address should be 192.168.000.002.] Then set the SubNet Mask on the computer to the same number as found on the MX-2424 in Menu 951, (255.255.255.000). The connection is made via a single Category #5 crossover cable. The use of a Hub for a single machine is discouraged, but is possible. If multiple systems are used to increase the number of tracks, each machine will need its own Cat-5 cable non-crossover cable sent to a Hub. The Master machine’s IP Address should remain the same, but the Slave machine should be 192.168.000.002, and the computer’s should then be 192.168.000.003.

The MX-2424 & Hard Drives:

  The MX-2424 comes in two base configurations; the Standard MX-2424, with the internal 9GigaByte SCSI hard drive and the MX-2424SE, with an 18GigaByte SCSI hard drive, in a StorCase Data Express DE-100I, hot swappable frame and carrier, which is mounted in the unit’s front internal bay. This Unit does not have the internal 9Gig mounted in the unit. All though these are the only two ways the units are offered, the intent of the unit is to be a Multiple Drive System. This means the optimal performance of the unit is when there is an internal drive and a hot swappable drive in the front bay or an external drive connected to this unit. This allows you to use the internal hard drive as a transfer and backup drive for moving data around, and the hot swap or external drive for recording projects and storage.

  This in itself is important because, no drive should ever be filled intentionally beyond 80% full, as this limits space on the drive for compiling and transferring information while promoting fragmentation. This may manifest itself as a “Media Too Slow” error, meaning that the drive can not cope with the fragmentation on that project. Tascam offers the additional hot swappable drive as an option either as an internal configuration or an external configuration, but you are not required to buy from us. 

  It is important to know though, that the Data Express DE-100i, must include an isolator board, (i.e. Repeater Board), from StorCase, when mounted in the front bay. It is important to note that the Data Express DE100I be of the proper SCSI type for the drive you are using. In other words, if you are using an Ultra 320 drive, be sure that the Frame and Carrier are for an Ultra 320 drive. Note that an Ultra 320 drive can also be used as the internal drive unit. 

  An additional external 68pin LVD/Ultra 2, 160 or 320 SCSI connector is standard on the back of the unit for connecting additional drives and backup units. The maximum size of a hard drive should be no more than 72GigaBytes external or 36GigaBytes internal when both an internal hard drive and a hot swap internal drive exist. This limit on these two internal drives is because of heat buildup inside the MX-2424. This heat build up can destroy one or both of these drives. The minimum specs’ for the Hard Drives should be; 7200rpms or faster, a seek time of less than 8.5ms and a data transfer rate above 18meg/sec.

The MX-2424 & Backing Up:

  On the subject of backups, Tascam offered a DVD-RAM unit, made originally by Hitachi as the 5.2Gig, GF-1050, and the 9.4Gig, GF-2050. The DVD-RAM, last used was provided by Panasonic, as 9.4Gig, LF-D291. These DVD-RAM’s use a 5.2Gig or 9.4Gig, Dual Sided “Type-1 or Type 4” DVD-RAM. The DVD-RAM should only be used as a long term archiving device, as it takes a substantial time to backup and reload to and from this device. Short-term storage should always be done on multiple hard drive units, as no formats need to be changed in moving projects between drives. This in turn means that transferring information between hard drives takes only a few seconds as opposed to the minutes it takes with the DVD-RAM.

  Whenever transferring projects between hard drives, be sure to name the transferred project slightly different, as transferred information that is named exactly the same will only set up a reference header on the new drive and not transfer the project itself. This means that when you access this information on the new drive, it is referenced and played back from the old drive because the file information of the project, did not get copied to the new drive, just a reference header that refers the system back to the project on the old drive. This is because the MX-2424, while recording to only one drive at a time, reads from all hard drives connected to the system at once. In this way a given “Project” may span several drives. 
  An optional, if not better solution to data back up, is to backup to your computer through the Ethernet. This takes no longer than backing up to the DVD-RAM and has the added benefit that this backup can actually be exported as a “wav.” file. The MX-2424 writes all its files as “open .TL” files. These when backed up are seen as “.BU” files, (Back Up). Only the MX-2424, the SX-1, E-Magic’s Logic Audio or Steinberg’s Nuendo, support the opening of these “open .TL” files. Tascam offers no support of “open .TL” files in Logic or Nuendo. 

  What this means is that if an error occurs once these files have been transferred back to the hard drive, that these files will often be non-recoverable. These errors are generally known as “Parse Errors” or a “MacOpen (exists) Failure”, if the drive format was HFS+. By Exporting as a “wav.” file, that file can be opened on any system with a Digital Audio Program that supports, “wav.” files. This is almost every Digital Audio Program that exists. In other words, if files on your MX-2424 become corrupted, you have a way to recover your data by re-importing those files from the computer. If for any reason the files cannot be imported back into the MX-2424 via the Ethernet, then the file can be played back into the MX-2424 either digitally through the digital I/O or analog through analog I/O, depending on which I/O that you have. Here you can see how it might be helpful to have both the analog and digital I/O’s, and the necessity of choosing the right interface to go with your computer system and it’s sound card. The other added benefit to backing up to a computer is storing your backup to CD-R, CD-RW or DVD-R in your computer.

MX-2424 System Health:

  The health of your Mx-2424 system depends a lot on stay abreast of current softwares available. The Tascam website should be checked periodically for the latest Mx-2424 OS, (operating system), and current MX-View version. As well as updating software, periodically reformatting the drives is a must. 

Formatting:

  It is necessary that the drives be reformatted regularly to ensure proper operation. A fresh format and initialization will ensure that the disk is read properly. Long periods between formatting can be another cause of  “Media Too Slow” errors. This is because as the disk fills up with data, that data does not really go away when you erase or delete a track or project. Erasing and deleting only tells the system that it is all right to record over those particular sectors involved in whatever information was told to be erased or deleted. This is kind of like recording overdubs on audiotape. In other words, the header information at the beginning of that sector tells the system whether the sector is ready to be reused or not. This doesn’t really erase anything other than the Header information that was pervious there to identify that sector as in use. Low Level Formatting, actually attempts to return the disk to a virgin state, putting the entire disk at a low level, (i.e. all zeros, no ones or that is, high states). 

  It is also wise to reformat a drive that you have just finish using and have unloaded the current projects on it for archiving, before going on to use this disk again. This ensures that your new recording projects will have plenty of space and be free from major fragmenting and errors. 

  Menu 711 is for the Low Level Formatting of drives. You must first unmount the drives on the MX-2424 by pushing “Shift” and “Mount”. Unmounting the drives should always take place when turning off the MX-2424 also. This allows the drives to decouple from the system and prevents damage both physical and data-wise. Once the drives are unmounted the target drive can be selected and the format procedure can begin. The unit will ask you if you’re sure you want to format. This is your last chance before erasing all your material on that drive. Give it a good look and make sure your formatting the right drive. A format can not easily be reversed. After formatting, which will take about one and a half minutes for every Gigabyte of drive space; you must initialize the drive. Menu 710 is the initialization menu. You must select the target drive and the type of disk encoding that you want. Fat 32 or, (wav 16 or 24 bit), for PC’s; and HFS+ for, (SDII 16 or 24 bit), for Mac’s. Mac’s will also be able to read “wav.” files. SDII stands for Sound Designer II files, which are used with ProTools.

Updating Software:

  Updating the software is done through the MX-View program, on your computer and the use of a “Smart Media” card. The “Smart Media” card must be the 4MB card that comes with the system. Larger cards will not work. New cards are available from our Parts Department, with the latest system software, already loaded on the card. 

  After putting the Smart Media card into it’s receptacle on the MX-2424, the first thing to do, to get started is download the updated software from the website to your desktop or put the latest software CD in the appropriate CD-ROM drive of your computer. Next, in the Network window of the MX-View software, under the “Machine” pull down menu, select “Update Software” as the task to be performed. This will initiate the upgrade procedure and write the software to the Smart Media card. Once the procedure is complete, it requires only that you power the MX-2424 off and then turn it back on while the card is still in the unit; for the software to be written to the MX-2424’s static ram. A simple reboot of the system will now complete the procedure.

System Clock:

  It is extremely important that system be properly clocked. The efficient transfer of information depends highly on how the system is clocked. The best clock is going to be Word Clock. Word Clock is a signal derived from the internal sample clock of the master Digital Unit, Or a master clock system. This sample clock is sent out the Word Output and forces all units slaved to it run in phase accuracy. This means that if the sample rate is 48KHz in the master unit, another unit slaved to that master will have its clock frequency the same as the master and its sample rate will be exactly in phase with the clock on the master unit. 

  One digital audio unit of your system or a Master Clock Generator must be designated the Word Clock master. All other digital audio units within your system would then become Word Clock slaves. Usually your master digital audio multitrack recorder or your digital audio mixing console is designated as the Word Clock master. The MX-2424 offers a Word Clock connection of In, Out, and Thru.

  The best situation for Word Clock is from a house Word Clock generator or a Master Clock Generator. A house Word Clock generator can be clocked off of Video Sync, also called Black Burst. Video Sync is used for syncing picture. In order that sound and picture line-up properly, Video Sync must be used. The Master Clock Generator, generates Video Sync, Word Clock and Usually SMPTE Time Code all in sync. 

  The MX-2424 has a Video Sync Input and Thru. It also includes Word Clock In, Out and Thru. When clocked to Video Sync, the MX-2424 will output Word Clock locked to Video Sync.

  Additionally, the MX-2424 can be clocked via the I/O on either the T-DIF interface, the LightPipe interface, the AES/EBU interface or the single port AES/EBU and S/PDIF I/O’s. Clocking can be sent from these interfaces and I/O’s on the unit, to facilitate clocking of a digital audio device that does not have a Word Clock input.

  The Mx-2424 supports the 44.1KHz, 48KHz, 88.2KHz and 96KHz, as well as all the associated pull-ups and pull-downs to support 24 Frame, 25 Frame and NTSC. Menu 002 is the Sample Reference menu where the choice of clock is selected. Menu 005 is the Sample Rate menu where the actual sample rate is set.

Creating a Basic “Project”:

  In order for Data to be stored on the MX-2424 a new project must be created on the system to have a place where the Data can be save to. The “Project,” is intended to be that place where the information from a song or program is saved. Avoid sending to much Data to one project. Never send multiple songs into one Project, unless it is a live recording. The larger and more complex a Project is the harder it will be to work with and congruously, the more problems you will have.

  To create a new Project; on the front Panel of the unit, push the shift button, below the LCD screen on the right and push the PROJ button on the right side of the Scrub Wheel. This will bring up the 800 menu in the LCD display. Line one in the LCD will read: 800 Project Name. Line two will be the name of the last Project loaded. Using the Scrub/Shuttle Wheel, you can enter the letters and numbers for the name of your song or project. The Shuttle Wheel changes the letters and numbers. The Scrub Wheel cursors to the left or the right.

  All new “Projects” must be created from the front panel. There is no facility in MX-View to create New “Projects.” This is to prevent inadvertent problems and loss of data.

Importing and Exporting:
  The MX-View program allows the user the ability of importing and exporting “.wav” or “SDII” files. This is accomplished in the “Import/Export Audio” window. By selecting a “Project” to be opened, the “Import/Export Audio” window will show all the various tracks within that “Project”. 
  Projects that are still in the “Non-Destruct-Mode” will need to be “Tape-Mode-Converted” if the tracks you are using are not one entire track from start to finish. This promotes proper time-stamping within your project. If your tracks are not one long continuous track, i.e. having edits, overdubs or missing spaces where you have deleted information; that tracks audio will be pushed together towards the start time of your project. In other words, your time-stamping through out your project goes away and only the actual start of the project is in time. If you have continuous tracks through most of your project you can use the “Render” function in the “Edit” Menu of the Edit Window to create one long track of individual tracks. Otherwise, if you have a project where multiple tracks have been edited, you want to use “Tape-Mode-Convert”. “Tape-Mode-Convert” will be found in the “File” Menu of the “Project/Track” Window.
  Once converted, these tracks can be downloaded into your computer via the “Download” command or the “Batch Download” command, (if there is more than one track to download), in the “File” Menu of the “Import/Export Audio” window. This will bring up a window on your computer asking you where you want to Save these files. You can Save them to your Desktop, or a folder in your hard drive but you can not Save them directly to a CD or DVD.
  Similarly, you can “Upload” a “.wav” or “SDII” file from your computer to the MX-2424 by choosing “Upload” in the “File” Menu of the “Import/Export Audio” window. This will give you an “Open File” window on the computer so that you can direct it to the file you wish to upload. Once upload, you can load these files to your “Clip Board”, or a “Selected Event” or the “Original Time-Stamp” in order to insert them into the selected track in the selected project. The “Load To Clip Board”, “Load To Selected Event” and “Load To Original Time-Stamp” will be found in the “File” Menu of the “Import/Export Audio” window.
